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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation Guide. The
Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform insurance
rating and underwriting technology solution that provides integrated management for every
aspect of the rate definition and modification process. This guide assists with the installation of
the Insbridge Rating and Underwriting System.

NOTE: RateManager and IBFA have been tested on MS Windows 2008 64-bit.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

PLANNING YOUR IBRU SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added
later on. The Oracle Insurance Insbridge Rating and Underwriting system (IBRU) is expandable
and can accommodate a few different configurations.

For more on planning your IBRU system, please see the Insbridge Implementation Guide.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

o Full RateManager: This installation installs RateManager and the Insbridge Framework
Administrator (IBFA) for 32-bit or 64-bit. This is for a Windows only environment using a
SQL Server database.

SoftRater Installation

o Full SoftRater for Java Installation: This installation deploys SoftRater to an application
server; WebLogic, WebSphere or JBoss, using a SQL Server database or an Oracle
database.
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Full SoftRater for Windows Node: This installation is for existing environments that
want to add a SoftRater for Windows node to an environment. This is for a Windows only
environment using a SQL Server database, or an Oracle database.

Upgrading a Current Installation

Upgrade: This installation is for existing customers and will take their current version of
IBRU up to version 04.06.01.

This guide is for a Full RateManager installation.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

IBRU: Insbridge Rating and Underwriting System. This is the entire system.

IBFA: Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS: Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within IBRU that executes
the rules, rating and underwriting instructions as defined by the user in RateManager.
IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

SoftRater Node: A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

SoftRater Native: SoftRater Native is a remote instance of SoftRater that can execute
rules and rating logic in environments where access via the SoftRater web-services is not
desired or possible.

RM: RateManager. RateManager is a component within IBRU that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

SR: SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

SR-WIN: SoftRater for Windows. This is also another name for IBFA.

SR-JAVA: SoftRater for Java. This is also another name for IBSS.
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o SRP: SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

o VFS: Virtual File Servers. Virtual file server management allows you to access
environments that are located on other machines in different locations where packages
can be downloaded.

o Package Location: A pointer to a location where SoftRater Packages (SRP’s) are
stored.

o Physical Environment: A physical environment is generally referred to as a physical
machine.

e Authoring Environment: The physical machine where RateManager is installed.

e Rating Environment: The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

o Logical Environment: An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other

supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

RELATED DOCUMENTS

For more information, refer to the following Oracle resources:

o The Oracle Insurance Insbridge Rating and Underwriting Operating Environments for
Hardware and Software.

e You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

CONVENTIONS

The following text conventions are used in this document:

Convention  Description

Boldface type indicates graphical user interface elements associated

eils with an action.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code

in examples, text that appears on the screen, or text that you enter.
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Chapter 1

SYSTEM REQUIREMENTS

IBRU installers should be familiar with managing a Windows server. There are two options for the IBRU
install, 32-bit or 64-bit. Please be sure you have downloaded the correct install for your machine.

Required Components

The following components, web server roles, and features are required:
o Afullinstallation of Microsoft Windows Server 2008

e Microsoft .NET Framework version 3.5
o |IS: Internet Information Services version 6.0 or 7.0

o Web Server Role: IIS 6 Metabase Compatibility
o Web Server Role: (11S) Static Content
e Web Server Role: ASP.NET

o MSMQ: Microsoft Message Queuing Services, basic functionality only.

e Insbridge User Account

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where IBRU will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Insurance Support.
The installation downloads you can select are:
o Insbridge IBRU Install: This is required for all RateManager installations. There are two options
for the IBRU install, 32-bit or 64-bit. Please be sure you have downloaded the correct install for
your machine.

o SoftRater for WebSphere: This is required if you are using WebSphere

o SoftRater for WebLogic: This is required if you are using WebLogic
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o SoftRater for JBoss: This is required if you are using JBoss

o Documentation: It is recommended that you download the documentation. Installation guides
and user guides are located here.

The 04.06.01-Insbridge-IBRU folder contents:

- Databases

¢

DB2
- SoftRater: IBSR
o DDL
Oracle
- SoftRater: IBSR
o DDL
0 Update: Usp_IBSR_v04.05.00.0racle
SQL Server
- RateManager: IBRM
0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security: IB_CLIENT
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater: IBSR
0 Latinl_General_BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
0 Update: Usp_IBSR v04.05.01.sql

- |E7_IE8 Users

¢
¢

Insbridge RateManager Setup Document PDF
RateManager_IE7_I|E8.exe

- Oracle Bl Publisher

*

OBI_PUBLISHER.exe

- Oracle Client

*

Oracle_client.exe

- Oracle Insurance: Insbridge Rating and Underwriting.exe

You will be required to run the installation file and create the IB_CLIENT database for any new
installation. The other folders and files may not be needed, depending upon the kind of setup you want.
Everything for a Windows only installation is in the 04.06.01-Insbridge-IBRU folder. If you want to
incorporate a Java environment, please download the corresponding SoftRater file. SoftRater downloads
are not required if you are running in Windows only.
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Quick View

RATEMANAGER INSTALLATION

Installing RateManager requires that you:
1. Set up Windows. There are three steps in setting up Windows for a RateManager deployment.

2. Install IBRU using a SQL Server Database

Setting up Windows

Step 1: Set up an Insbridge User.
Step 2: Windows 2008 web server roles.

Step 3: Verify SQL Server settings.

Installation Procedures: Full RateManager

Step 1: Install Insbridge Rating and Underwriting

Step 2: Configuring Registry Access

Step 3: Assigning Permissions: Windows Temp Folder
Step 4: Assigning Permissions: Insbridge Folder

Step 5: Restoring IBRU Databases in SQL Server
Step 6: Configuring Insbridge Framework Administrator
Step 7: Verifying the Component Services

Step 8: Allowing for WCF Activation

Step 9: Installing the OBI Publisher

Step 10: Starting Insbridge Services

Step 11: Performing Updates in RateManager

Step 12: Export Insbridge Registry Key for Backup
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Chapter 2
SETTING UP WINDOWS

IBRU installers should be familiar with managing a Windows server.
If you are installing on a 64-bit machine, please make sure you have the IBRU 64-bit download.

Windows Server should be up and running prior to RateManager being installed. There are three steps
that should be performed prior to the install:

e Step 1: Set up an Insbridge User. This is a required step.
e Step 2: Setting Windows 2008 web server roles.

o Step 3: Verify SQL Server settings.

STEP 1: INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being
installed. This user needs to be a member of the User group and requires certain privileges in order to
fully control the entire IBRU environment. For ease of installation and if the server is dedicated to the
Insbridge Rating and Underwriting System, it is suggested that this user be added to the local machine
Administrators group.

If the installer has permissions, an Insbridge user can be created during the installation.

To Create a New User:

1. Select Start->Administrative Tools—> Server Manager.
2. Select Configuration—>Local Users and Groups.
3. Select Users.

4. Right click and select New User.
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E== Server Manager

File  Action View Help

M[=]F3

€2 | fmlc=HE

% Server Manager (WINSRPOO1)

Actions

i.-‘ Roles —
= Festures MName Full Mame Description
% Diagnostics A admin Account For IGEU IT Access Do not change
= 3?!_ Configuration A ndministr atar Built-in account For administering the. ..
i - . - L .
Task Schedulsr L i BE psstat..
‘Windows Firewall with Adve !
3 A
5k Services < .
:EEH WHI Contral ! User name: ||
E P Local Users and Groups I I
7] Users
|| Groups Descriptian: I
25 Storage
Pazsword: I
Caonfirm password: I
¥ User must change password at nest logon
I™ | Uzer cannot change passward
I™ | Fasswordnever expiies
[~ Accourt is disabled
| cs_|

‘;I—I ]

Users
fore Actions
Insbridge

Mare Actions

Figure 1 Creating New User

5. Add a new Insbridge user. Enter user name and password information. Uncheck User must
change password at next logon. Check User cannot change password and Password never

expires.

6. Click Create.

as the internet guest account.

Close the Add New User screen and select the Insbridge user. Right click and select Properties.

The Insbridge User should be assigned to the local Users group and have the same permissions

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user
cannot be a part of the local administrators groups, please make sure that the Insbridge user has

permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.
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Insbridge Properties H I

Rermate cantral | Terminal Services Profile | Diakin
General | b ember Of I Prafile I E nvironment I Seszionz

L Inzbridge
o

Full narme: Ilnsbridge

D escription: Inzbridge User

™| Wser must change pazsword at nest logon
¥ Uszer cannot change password

¥ Pazsword never expires

[T Account is dizabled

[T Aceount is locked out

] 4 I Cancel Apply Help

Figure 2 Adding User information

9. Click OK. Please keep the Insbridge user information close at hand. You will need it for the
installation.

NOTE: You also can create the Insbridge User from within the install. If you create an Insbridge user from
the install, you may not be able to set the permissions you need. Please be sure to verify the
proper permissions are in place before continuing.

Insbridge User Password

The password can be set to any password that meets your company standards. The IBRU administrator
must make note of the password for future configuration.

For ease of maintenance, the IBRU user should not have to change the password and the password
should never expire.
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The installation automatically applies the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This will
recreate the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password. Be aware that re-installing the application will also reset security settings in IBFA
as well.
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STEP 2: WINDOWS 2008 WEB SERVER ROLES

Windows 2008 requires that certain web server roles are in place prior to running the install.
e Web Server Role: IIS 6 Metabase Compatibility
e Web Server Role: (1IS) Static Content

e Web Server Role: ASP.NET

Eh Server Manager !E I

File Action View Help
&= 5|

) Roles

7| Features
Dizanostics +  View the health of the roles installed on your server and add or remove roles and features.
it Configuration =

=3 Storage

. =
'~ Web Server (IIS) Web Server (II5) Help

Provides a reliable, manageable, and scalable Web application infrastructure.

(~) Role Status [ Go to Web Server (115)

Messages: Mone
System Services: 3 Running, 1 Stopped
Events: None in the last 24 hours

(~] Role Services: 13installed St Add Role Services
e [smns I &5 Remove Role Services
& Web Server Installed
& Common HTTP Features Installed |
& Static Cantent Installed
& Default Document Installed
Directory Browsing Mot installed
HTTP Errors Mot installed
HTTP Redirection Mot installed
[Q'J, Application Development Installed
& ASP.NET Installed
& \NET Extensibility Installed
ASP Mot installed
CGI Mot installed
& ISAPI Extensions Installed
& ISAPI Filters Installed
Server Side Indudes Mot installed
Health and Diagnostics Mot installed
HTTR | nnninn Nt inctallad LI

3:: Last Refresh: 5/25/2011 2:05:41 PM  Configure refresh

|
Figure 3 Windows 2008 Web Server Roles
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To Add a Role:

1. Start=> Administrative Tools—> Server Manager—> Roles> Web Server (11S)-> Add Role Services.

E,= Server Manager
File  Action View Help
|7

f}.! Raoles
{4 Features

f‘! Diagnostics | 4 View the health of the roles installed on your server and add or remove roles and features.
i configuration =

22 storage —

Basic Authentication Mot installed
Windows Authentication Mot installed
Digest Authentication Mot installed
Client Certificate Mapping Authentication Mot installed
115 Client Certificate Mapping Authentication Mot installed
URL Authorization Mot installed
& Request Filtering Installed
IP and Domain Restrictions Mot installed
Performance Mot installed
Static Content Compression Mot installed
Dynamic Content Compression Mot installed
& Management Tools Installed
& 115 Management Consaole Installed
115 Management Scripts and Tools Mot installed
Management Service Mot installed
.:i._. 115 & Management Compatibility Installed
& 115 & Metabase Compatibility Installed
IS & WMI Compatibility Mot installed
1IS & Scripting Tools Mot installed
IIS & Management Console Mot installed
FTP Publishing Service Mot installed
FTF Server Mot installed
FTP Management Console Mot installed
Description:

1IS 6 Management Compatibility provides forward compatibility far
your applications and scripts that use the twa 115 APIs, Admin Base
Object (ABO) and Active Directory Service Interface (ADSI). You can
use existing IIS 6 scripts to manage the IIS 7 Web server.

Figure 4 Adding IIS 6 Metabase Compatibility

2. Install IS 6 Metabase Compatibility.
3. Install Static Content.
4. Install ASP.NET

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.
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STEP 3. MICROSOFT SQL SERVER

For the Insbridge 04.06.01 release:
e The IBSR database has been tested on MS SQL Server 2008 SP/1 on MS Windows 2008 64-bit.

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the IBRU web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.

Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication: Should be set to SQL Server and Windows Authentication mode.

e Collation and Sort Order: Currently supported is the default SQL Server collation using
SQL_Latinl_General_CP1_CI_AS and sort order plus case sensitivity using Latin1_General_BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latinl_General_CP1_CI_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
guestions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.
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DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the IBRU databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Rating and Underwriting System will fail. An experienced database administrator’'s expertise is
highly recommended before making any security changes.

Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have:

e A database owner (db_owner) role. db_owner access is needed to execute the Insbridge
stored procedures and have full access to the Insbridge schema.

o Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, manual steps will

need to be performed to update the databases. If disk admin permissions are not allowed, backups will
have to be done outside of RateManager.
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Chapter 3

FuLL RATEMANAGER INSTALLATION

This installation will install RateManager and the Insbridge Framework Administrator (IBFA). This is for a
Windows only environment, using a SQL Server database.

Before installing, please verify that the system requirements are in place.

DEVELOPMENT
The installation should be performed in the following order: Raﬂ:gt:nd_ Rules
uthoring

1. Install the IBRU application.

2. Assigning Insbridge access to the Registry. '"ls;::":

3. Assigning permissions to the Insbridge User for the Windows T
Temp Folder. This is necessary for MSMQ. You also need to AT
assign permissions to the Application Pool Identity. SUBSCRIBER

Must be the same

4. Assigning permissions to the Insbridge User for the Insbridge in all envirenments
Folder.

ADD

5. Creation of the IBRU databases is next. There are two databases =
that must be in place. c;;m:gr

Ll
a. IB_Client G
b. IBRM
CREATE:
6. Enter IBFA and Configure: Logical
. Environments:
a. Create your subscriber.
RM — to hardle
b. Add database connections. testingfrating.
. . QA_SR - This
c. Create your logical environments. environment
contains e il

7. Verifying Component Services. s

8. Allowing for WCF Activation. This is required. —

9. Install OBI Publisher.

X . PURPOSE of this Physical

10. Start Insbridge Message Service. Environment

11. Login to RateManager and perform IBRU database updates. This environment is for the

creation of rating programs.
12. Create Backup of Registry Key. This environment also holds
the security information.

A Windows 2008 Server installation must be run as Administrator.

IB_CLIENT
security

Attach to

holds Rating
& Rules
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STEP 1. INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file.

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance - Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance - Insbridge Rating and Underwriting file. A Welcome screen is displayed.

i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

4 Oracle Insurance Insbridge Rating and Underwriting

[t iz gtrongly recommended that you exit all Windows programs before running this setup program.

Click Cancel tao quit the setup program, then cloze any programs vou have running. Click Mest to
cantinue the installabion.

WIARMIMG: Thiz program iz protected by copyright law and international treaties.

|Inautharized repraduction ar distribution of this pragram, or ang partion of i, may result in zevere civil
and criminal penalties, and will be prozecuted to the maximum extent pozsible under law.

ORACLE

INSURANCE

Cancel |

Figure 5 Installing Insbridge

3. Click Next to continue.
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The “Wize [nstallation Wizard will install the files for Oracle [nsurance - Insbridge A ating
and Undenwriting in the following folder.

Toingtall into a different folder, click the Browse button, and select another folder.

f'ou can chooze not ko install Oracle Insurance - Insbridge B ating and Undensriting by
clicking Cancel bo exit the YWize [nztallation wizard.

Deztination Falder

C:AProgram Filezh\OraclehGELUY nzbridges Browse. .. |

Wize Inztallation wWizard [R]

¢ Back I MHewt > I Cancel

Figure 6 Entering the Destination Folder for Insbridge

Choose the location where the Insbridge installation will be installed. A default installation folder is
created for all new installs. This will be the location for all future installations for Insbridge
applications. Select Browse if you want to install in a different location. After selecting a location, click
Next to continue.
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Logon Information DRACLE

The fallovaing logon information = uged by Insbrndge. INSURANCE

Specify a user account ko be used by the application, either for running a service or for
logging onto other servers. Use the Browse button to choose uszers from pour nebwork,
For domainz, uzer names must be in the format of DORAINY ] zert ame.

Uzer Marne: |Insl:uriu:|ge Browse... |

Pazzward: | [[]I]]

Create Hew User..

Wize Inztallation wWizard [R]

Cancel |

Figure 7 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen is displayed. You must specify a user account to be used by the application.
Please use the Insbridge user account that you set up on page 13.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Select Features DRACI_E

Fleaze select which features pou would ke to ingtall. INSURANCE

= {g 'I Inzbridge B ating & Lndenariting Feature Description:

=3~ | RateManager Oracle Insurance Insbridge Rating and

e Sl w | |BFA Urdenariting is a Web-based rating, rules, and
e () v| Oracle Bl Publisher Reports undemuriting spstem.

T hiz feature will be inztalled on the local hard
drive.

Thiz feature requires OKE on your hard drive. It
haz 2 of 2 subfeatures selected. The subfeat. .

Current location;
C:APROGRAK FILESYORACLEMGEUMMNSERIDGE®,

Wize Inztallation wWizard [R]
Dizk Ciozt Rezet

Cancel |

Figure 8 Selecting Features for Installation

7. The next screen lists the applications to be installed. To expand the options and view details, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you

will be allowed to not install. Click Next to continue.
Options are:

e Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

o RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

- This option does not install the OBI Publisher. Only the templates required by the IBRU

application will be installed on local hard drive.
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i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup M= B3 |

Ready to Install the Application ORACLE

Click Mest to begin installation. INSURANCE

Click the Back button to reenter the inztallation information or click Cancel to exit
the wizard.

Wize |nstallation YWizard [R]

Figure 9 Ready to Install

8. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the
options you want to install.

i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting Setup M= B2 |

Updating System ORACLE

The features you zelected are currently being installed.
Y v heEing INSURANCE

Stopping services...

Service: Inzbridge Meszzagellueue Service

Time remaining: 21 zeconds

Wize |nstallation YWizard [R]

LCancel

Figure 10 Installation Progress
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Readme Information DRACLE

Inzbridge haz been succezsfully inztalled. INSURANCE

Microsoft Windows 2003/2008 Server &
A full installation of Microsoft Server 200372008 is required. The following
configuration assumes that the administrator of the server to be generally
familiar with managing a Windows server.

Internet Information Services {l15)

The InsBridge Rating and Underwriting Systern is a web based application and
requires 115 to be installed before installation to facilitate the default web virtual
directories creations.

The subcomponents of 15 needed by IBREL:

. Comrmon Files
. Documentation
. Internet Information Services Snap-In hd

Wize Inztallation Wizard®

Cancel |

Figure 11 Install ReadMe Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2: CONFIGURING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge

Assigning Permissions for the Registry Access

1. Select Run from the Start Menu.

2. Type regedt32. Click OK. The Registry Editor will open.

&' Registry Editor

File Edit

Wiew Favorites Help

(=78 Computer

. HEEY_CLASSES_ROOT

- HKEY _CURREMT _USER.
- . HKEY_LOCAL_MACHINE

- | BCDO0000O000

- | HARDWARE
L SAM
----- | SECURITY

&)
[ [ COMPONENTS
&)
&)

=1+ . SOFTWARE

- Classes
- Clients
- L Ghy

Expand
Mew
Find...

Delete
Rename

S 0 O oy O O e O e e O O e e O O e

Export

F- | WOWE43ZNode

[
-
-

|- [ SYSTEM
. HKEY_USERS

. HEEY_CURREMT_CONFIG

- . Hewlett-Packard

----- ) Petmissions...

..... p Copy Key Mame
----- . Registeredapplications

Mame

Type | Data

ab|(Default)

REG_5Z (value not set)

|ComputeriHKEY_LOCAL_MACHINE\SOFTWAREInsbridge

Figure 12 Configure Registry Access Windows Server
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3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE->Insbridge.

4. Right click and select Permissions.
5. Scroll through the users. Select the Insbridge user.
6. Verify that the Insbridge user has Full Control.

7. If the Insbridge user does have Full Control, cancel out of the registry and continue with the
installation.

8. If the Insbridge user does not have Full Control, change permissions to allow for Full Control.
Save your entry and close out the registry. Continue with the installation.

9. If the Insbridge user is not listed, follow the step to add the Insbridge user.

Adding the Insbridge User:

1. From the Permissions screen, click Add.

2. Onthe Select Users or Groups popup, you can leave the defaults for the Object Types and
Locations or enter the values you require.

Select Users or Groups ﬂ E

Select thiz object tupe:

ILlsers, Groups, or Built-in secunity principals Ohject Types...

Frarm thiz location:
IWIN:L‘-.F'F'IZIEH Locations. .

Enter the abject names to select [examples]:
Irsbridge] Check Mamesz

P16

Advanced... | k. I Cancel

Figure 13 Entering the User

3. Enterin the user name (insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find Now
and scroll through the list until you find the user name you need. If the user name is not listed,
return to User Accounts and verify the user name was created.

4. Once the name is listed, click OK.
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. Permissions for Insbridge |
SecLrity |

GTCILIFI ar Uzer hames:

52 CREATOR OWNER

5L SYSTEM

b 4 Insbridge (/N1 nsbridge)
"'ﬂd.-’-'-.dministratn:nrs (WM OO \Adrminiztratars]
"‘v?,_ I zers WINOOTA 2ers)

Add... | Remove |
Permizzionz for Inzbrdge Aflone Ceny
Full Control O
Read O
Special permizsions O O

Faor special permizsions or advanced settings, Advanced |
click Advanced.

Learn about access contral and permissions

k. I Cancel | Smply |

Figure 14 Applying Permissions

On the Permissions screen, make sure the insbridge user is highlighted and check to give Full
Control to the entire Insbridge key.

Click OK.

Close the registry and continue with the install.
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STEP 3: ASSIGNING PERMISSIONS: WINDOWS TEMP FOLDER

Permissions must be assigned for the Windows Temp Folder for MSMQ and for the application pool
default identity. Prior to assigning permissions, please verify the default application pool identity.

Identifying the Application Pool Default Identity:

1. Open lIS. Start->Administrative Tools=>1IS Manager.

2. Expand the server and select Application Pools.

3. Select the DefaultAppPool.

“'E Internet Information Services (IIS) Manager

@ « o | £ » winsreoot b Appiication Paols

File  Wiew Help

Comnections L
TSI Q‘;lg Application Pools
-&5 5tart Page ) )
=83 WINSRPOO1(WINSRPOOL\Admini ?p;f;ﬁ;j:i:g“ “: Advanced Settings EHE
-2} Application Pools it
=[] Sites Filter: B (General) o
E@ De_fault Web Site Name =~ .MET Framework Version va2.0
_| aspnet_dient 2 Classic .NET App Enable 32-Bit Applications False
¥ IBFA ,%Deﬁ.lult.lﬁppPool Managed Pipeline Mode Integrated
g U DefaultAppPool
\? RM Queue Length 1000
Start Automatically True
E cPU
Limit a
Limit Action MoAction
Limit Interval {minutes) 5
Processor Affinity Enabled False —
Processor Affinity Mask 4294967295
Process Model
Identity NetworkService
Idle Time-out {minutes) 0
Load User Profile False
Maximum Worker Processes 1
Ping Enabled True
Ping Maximum Respaonse Time {seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
Startin Time |imit fzernnds) an bl
Name
[name] The application pool name is the unigue identifier for the application pool.
oK Cancel |
&

Figure 15 Verifying Application Pool Settings
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4. Right click and select Advanced Settings.

5. Take note of the Identity under Process Model. This user will need to be added to the Windows
Temp file. In this example, the Identity is NetworkService.

NOTE:
Application Pool.

If you want to create a separate Insbridge Application, please see Creating an Insbridge

6. Click OK to close the Advanced Settings screen.

7. Close IIS. No more information is needed from the Application Pool.

Assigning Permissions in the Windows Temp Directory:

1. Open Documents. Find the WINDOWS folder, most likely on your C drive.

2. Right click the Windows—>Temp folder.

ascl  Rename

ﬂ Temp !lil
(;( ;;v | = Computer = Local Disk {C:) = Windows = Temp - - l‘nl ISearch @
File Edit Wiew Tools Help
Organize > =5 Views (7]
Favorits Links Mame = | -I Dake modified I -I Tvpe I -I Size I v| Tags I -I
TestEngDated 2/812010 12:54 PM  File Folder
’T Documents | |DMI7FE.tmp 2/8j2010 10:30 &AM TMP File 0 KB
FE Pictures || DMIFCES kmp /82010 10:30 &AM TMP File OkKE
"[15 Music | Fwtsqrafilen. sqm 7/12[2010 12:56.,. SQMFile 1KE
Mare | Pwtsqrafiledt.sqm 7119/2010 1:118 PM S0QM File 1KB
| Pwtsqrafiledz. sqm 7/26/2010 1:34 PM S0M File 1KE
Folders w | |fwtsgmfile03.sgm g/2f2010 1:47 PM SOM File 1KE
| Pwtsqrafile4. sqm g/952010 1:53 PM S0QM File 1KE
Tasks ;I p ] ]
m | Fratsgmfile0s,sqm 8/16/2010 1:54 PM  50M File 1KE
Frutsgmil ; i
L1 qrifile0&. sqm 8/23/2010 Z:02 PM 50QM File 1KE
gL || Fwtsamiilea?. sqm 8/30/2010 2:07 PM  SQM Fils 1 KB
Explore | Pwtsgrafileds, sqm 4112/2010 3:23 PM - S0M File 1KB
Cpen J | Pwtsqrafiledd, sqm 4/19/2010 3:26 PM  50QM File 1 KB
| Fratsgmfile10.sgm 4f26/2010 341 PM S0M File 1KE
i || Fwtsgmfile11.sqm S/6(2010 9:38 AW SOM File 1KB
e DVD §J Scan For threats. ., | Fratsgmfile12,sqm 5/13/2010 150 AM QM File 1KB
=] 5-_:' Mekwo i : || Pwksgrafile13.sqm 5/24/2010 11:12.,. SQMFile 1KE
M 3ad  PeeStore previous versions || Frtsgmfile14.sqm 5/31/2010 11:27... SQMFils 1 KB
M| aMs[ send To || Prtsgmifile1S.sqm 6/7/2010 11:42 &AM 30QM File LKE
W AMS | Fwtsqrafile16.sqm 6f14/2010 11:58... SQMFile 1 KB
W aMs Cut || Ftsqmfile17.soqm 6/21/2010 12:06...  SQM File 1KE
-l_'.i AMS Capy || Pwksgrifile1.5qm &/28/2010 12:21... SQMPFile 1KB
:!i srpl  Delete | Fratsgmfile19.sqm 7/5/2010 12:37 PM SOM File 1KE
'_“ | |F#sTIFFDebuglogFile  4/29/2010 9:35 &AM Text Document OKE
=
L
i

HEEHEEHBRBBR

M|

Figure 16 Assigning Permissions for the Insbridge User on Windows Temp

3. Select Properties. The Temp Properties screen will open.
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Select the Security tab.

Click Edit.

On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge
user is not found, cancel out and return to the Local Users and Groups area in Server Manager

and verify the Insbridge user was created.

Update the permissions. The Insbridge user requires Full Control.

l Temp Properties |
. Generall Sharing  Security | Previous ‘u’ersinnsl Eustumizel

Object name:  C:AWindowshTemp

GTCILIFI ar Uzer hames:

Inzbridge [*/1M001 4 nsbridge]
‘ﬂ,.-’-'-.dministrah:urs (WM 0T Adminiztrators]
51 Ugers [WwWINDOT4U zers)

1S HISRS MAMOnsIs NSRSl
J

i

To change permizsiong, click Edi. W Edi...

Permizsions for Insbridge Al Deny

Full contral

b odify

Read & execute
Lizt folder contents
Read

Wiike

For special permizzions or advanced settings,
click Advanced.

LAENASAS

|_ILI_IL

Advanced

Learn about access control and permissions

] I Cancel | Apply |

Figure 17 Temp File Properties

Next add the Application Pool identity.

Update the permissions. The Application Pool identity requires the default permissions plus
WRITE.

. Click OK to close the Permissions for Temp screen.

. Click OK to close the Temp Properties screen.
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Assigning Permissions for an Insbridge Folder Location

STEP 4. ASSIGNING PERMISSIONS: INSBRIDGE FOLDER

1. Open Documents. Locate the INSBRIDGE folder, most often the Insbridge folder is located at:
C:\Program Files\Oracle\IGBU\Insbridge.

2. Right click the Insbridge folder.

H Insbridge =] I
= -
G\: Jv | ~ Local Disk (i) ~ Program Files « Oracle  IGBLU ~ Insbridge ~ - lmJ ISearch D)
File Edit Miew Tools Help
Jrganize - - _é
Favarite Links Mame - | -| Date madified | <] Tvpe | | size | -] T2gs |-]
COM+ 2/15/2011 4:31 PM  File Falder
[El pocuments Framework 4/29/2010 &:54 &AM File Folder
'E| Pictures Expand 2}15/2011 4:31 PM  File Folder
-‘TJ" Music Explore tR.ater 4/29/2010 5:54 AM F!Ie Falder
Mare Open bs 4/29/2010 5:54 AM  File Folder
Faolders ShiEiE..
inekpub & Scan far threats...
Instridge Restore previous versions
PerfLogs
=] Program Files Send To 4
Common File| =
Hyper-¥ Copy
Internet Exp
McAfee Eelete
MSEBuid Enams
= COracle e 3
= 1eEl Properties
Insbridgd
Packaged Programs
Reference Assemblies
Windows Calendar
Windows Defender
Windows Mail
Windows Media Player
wWindows MT
windows Photo Gallsry
Users
Sindows
<45 DVD Drive (D:)
£ Network
Conkrol Panel
£ Recycle Bin 4

Figure 18 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties. The INSBRIDGE Properties screen will open

4. Select the Security tab.
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5. Click Edit.

M insbridge Properties |
. Generall Sharing  Security I Previous Versinnsl Eustu:umizel

Object name:  C:5\Program FileshOraclebGE LY nebridge

GTDUD ar Uzer names:

[nzbnd ge | WwAMO0T S he |:|ri|:|gEe]
‘r?,.ﬁ.dministraturs (MO0 \Administrators)
‘ﬂ, Jzers [WwWiIMO0T W sers)]

.\,1 Trtedlnstaller
4

i

To change permizsiong, click Edi. I Edi...
Permizzionz for Inzbrdge Aflone Ceny

Full contral o -

b cadify J

FRead & execute o

Ligt folder contents vy

Read o

write " ;I
Far zpecial permizsions ar advanced zettings, Audvanced |

click Advanced.

Learn about access caontral and permigsions

k. I Cancel | Amply |

Figure 19 Insbridge Folder Properties

6. On the Permissions for INSBRIDGE screen, select the Insbridge user and click Add. If the
Insbridge user is not found, cancel out and return to the Local Users and Groups area in Server
Manager and verify the Insbridge user was created.

7. Update the permissions. The Insbridge user requires Full Control.

8. Click OK to close the Permissions for INSBRIDGE screen.

9. Click OK to close the Temp Properties screen.
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STEP 5. RESTORING IBRU DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latinl_General_CP1_CI_AS and sort
order plus case sensitivity using Latinl_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

¢ SQL Server
- RateManager: IBRM
0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security: IB_CLIENT
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
Security: IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “_ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Figure 20 Restoring a Database to SQL Server

6. Go to Databases.

B Microsoft SQL Server Management Studio
Fle Edt Yew Took Window Communty Help

D mewouery | Oy |3 |25 & |,

~ 3 X

New Database. ..

3 Security
(3 Server Ob)
(3 Replication
ca Managemf‘ Restore Database...

attach...

Restore Files and Filegroups. ..
Start PawerShel
Reports

Refresh

aRngsterEd Servers E Obiject Explorer

Ready

Figure 21 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen is displayed.

. Restore Database - IE_CLIENT_Alamere

Select L8 Seript - 4 Help

=] B3

1% General
1 Dptions

[Deztination for restore

Select or type the name of a new or exizting database for your restore operation.

To database: IIB_ELIENT_AIamere

To a point i time: IMost recent possible

Source for restore

Specify the source and location of backup zetz to restore.

" From database: I

I

Select the backup sets to restore:

% From device: IE:'\I nsbridgehDB_CleansB_CLIEMT bak

L

Restare I M ame I Companent I Type I Server

I Positic

rd Databaze Full DEWOm

Server
WIMNAPOINSOL

Connechan:
za

4¢ View connection properties

IB_CLIEMT_TEMPLATE 1

Figure 22 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:.

10. Select From Device. Click ... to browse to the location where the database files were placed in

step 3.

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step 4.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 38



14.

15.

16.

17.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Repeat for the RateManager database and any SoftRater database.

Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 35 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.
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STEP 6: CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

= Framework Administrator - Windaws Internet Explorer

‘g‘http:NLocthostﬁ’leaIdefau\t.aspx| v |¥ | X

Ny -

ORACLE" msurance Insbridge Framework Administrator Version 04.06.01 (x86)

[
= . Configuration File [C:\PROGRAM FILES\ORACLE\TIGBU\INSBRIDGE \FRAMEWORK\3.5.0\Insbridge.Xml

F3 SoftRater The Framework Administrator Web will configure any Insbridge Framework Configuration file (Insbridge. xml) found on your
H network, Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps

[3 softhata that reside on the same Framework Server share the same file.

+-C3 Services

B3 Logs Change Config File location: Edit| | Apply

3 security Click on "Edit” button to enable the text box above. Copy and paste the new Insbridge ¥ML file location in the text box.

click on "Apply™ button to apply the new configuration file.

Add Subscriber
The subscriber idghtifier is an unique number that you would like to represent your company. Please consult with an
gsbridge supaeft representative if you have any questions.

?:) SoftLibraries
- @) Help

# Mo Subscribers found,

Add Database Connection
Create or edit database connection. This database connection can be global to the Insbridge Framework ar unique ko the
Subscriber,

IClick on the name of the connection to edit.
Global

# Mo Connections Found.

Copyright @ 2000, 2009, Orade and/or its affiliates. All rights reserved.

Figure 23 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

NOTE: If you receive an error regarding MCSiMenuCltl, please verify that you are using Internet Explorer
8.0 or 9.0 (32-bit). Release 04.06.01 does not support Internet Explorer 8.0 or 9.0 (64-bit).
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There are five steps that will need to be done in IBFA:

Step 1: Creating a New Subscriber

Step 2: Adding a Global Database Connection

Step 3: Adding a Security Database Connection
Step 4: Adding an RM security Database Connection

Step 5: Creating a RateManager Environment

Step 1: Creating a New Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

1.

2.

Click on Add Subscriber on the Main IBFA screen. A separate screen is displayed.
Enter the ID, Name and Description for your subscriber.

When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

/A Subscriber -- Webpage Dialog @

Subscriber
Flease enter fupdate your Insbridge Customer information below.

1 3659
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

Figure 24 Enter ID
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NOTE: Make note of the subscriber ID number. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber. For
example, if you have an instance of IBFA on machine A, you can create a subscriber with an 1D
of 100. On machine A, if you create another subscriber, you must give that subscriber a different
ID number, say 200. If you also have an instance of IBFA on a different machine, B for example,
you should duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.

Troubleshooting Subscriber Entries:

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Goto C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Sharing and Security. Select the Security tab.

3. Add the Insbridge user.

Add Database Connections:

Stay on the Main IBFA screen. Three databases must be added to IBFA:

e Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the IBRU system. This is not unique to the subscriber.

e Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
database and is required for subscriber security information.

e Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

To continue, you will need to exact names of the databases you restored in Step 5, IBRM_xxxx, and
IB_CLIENT databases.

Step 2: Adding a Global Database Connection:

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.
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1. From the Insbridge page, click the Add Database Connection link. This opens the Connection
screen.

/2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber,

Subscriber: Global w
Mame: Controller
SErver: LocalHost Test Connection. ..

Server Type: | SQLServer b |

Catalog: IE_CLIENT

Catalog Type: | Other L |
Query Buffer:

Tablespace:

Schema:

User; ]

Password: EEEEEES

Save Cancel

Figure 25 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The

controller and security databases will both be type OTHER. The rm database will be type
RateManager.
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8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

/2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber,

Subscriber: | Global W

Mame: |

Server: Test Connection...

Server Type: | SQLServer hd |

Catalog:

Catalog Type: | Other w |

Query Buffer:
Tablespace:
Schema:
User:

Password:

Save Cancel

Figure 26 Adding a Database Connection

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed.

Step 3: Adding a Security Database Connection:

1. Next, add the security database. Select the Add Database Connection link again.
2. Select Your Subscriber. The security database is unique to the subscriber.

3. Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.
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4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.

7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

2 Connection -- Webpage Dialog @

Connection

Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: Alamere Insurance L4
Mame: Security
Server: LocalHost Test Connection, ..

Server Type: | SQLServer b

Catalog: IB_CLIENT

Catalog Type: | Other w
Query Buffer:

Tablespace:

Schema:

LUser: 53

Password: TLLTITIY

Save Cancel

Figure 27 Setting up the Security Database Connection
Step 4: Adding an rm Database Connection:

1. Next, add the rm database. Select the Add Database Connection link again.
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10.

Select Your Subscriber. The rm database is unique to the subscriber.
Enter rm for the Database Name. This cannot be changed once you have saved it.

The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 5.

Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

/A Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber,

Subscriber: Alamere Insurance w
Mame: RM
Server: LocalHost Test Connection...

Server Type: | SQLServer -
Catalog: IBRM

Catalog Type: | RateManager |w

Query Buffer:

Tablespace:

Schema:

User: 53
Password: LI

Save Cancel

Figure 28 Setting up the RateManager Database Connection
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NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Logical Environments:

Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:
e RM: to handle rating and testing.

You can create additional environments at this time if necessary or you can add them in at a later time.

Step 5: Creating a RateManager Environment:

It is recommended that only one RateManager environment be created.

1. Browse to SoftRater>Explorer>Subscriber name.

(= Framework Administrator, (WINAPPOO1) - Windows Internet Explorer

@.\-T_/. ~ [ httpiffLocainost/TER AjdeFaut aspx] v[»][x
Ele Edt View Favorbes Took  Help
— . . »
v e I@Fvamewnrkndmumstratm(WINAPPDm) I } [ R] oeh - | Page = (0} Tools -
ORACLE nsurance Insbridge Framework Administrator Version 04.06.00 (x86)

[x]
Settings
= nsbridge 9

EHd SofRater
L enine
Explorer Configuration
Environments.

SoftData
Services

Add Environment
Add, edit, ar remave enviferments fram yaur Explarer configuration.

Loas # No environments found.
Security

> Softlibraries . .
Line-of-Business Management

Your rating book of businesses are identified by an id and a description. There is na limit to the number of LOB's (ine-of-

business) that your Explorer can contain.

Help

ID - DESCRIPTION

# Mo Lines found.

Virtual File Server MHanangement

There are times when you must download SofiRater packages from different locations. These locations require a domain
name of an ip-address of the particular server.

DESCRIPTION - SERVER - TYPE - ENVIRONMENT

# No file servers found.

< |

v

Copyright @ 2000, 2008, Crade andor its affliates. All rights reserved.

Done % Local intranet H100% -

Figure 29 Create a Rating Environment

2. Click on Add Environment.
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/A Environments -- Webpage Dialog

A SoftRater configuration can suppart an unlimited number of environments,

Mame: RM_Default

Type: | Dey (¥

Secure: [

Save Cancel

Figure 30 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your IBRU
system is designed.

There are three types of Logical Environments:

o Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

DRACI_E. Insurance Insbridge Framework Administrator

x|
B Insbridge S

EILj SoftRater

|_:I Engine

=0 Explarer Add Environment

Add, edit, or remove environments from your Explorer configuration.

- SoftData
L Services % BRM_Default - Development
F-[J Logs # QualityControl - Quality Assurance
5-CR Security # SR RM - Production

Figure 31 Obtaining Environment Information
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4. Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

rf_‘: Framework Administrator - Windows Internet Explorer

@ :—; - \g, http/fLocalhastjibfafdefault. aspy| SAIRE RS
ORACLE nsuance Insbridge Framework Administrator Version 04.06.01 (x86)
[x]
513 Insbridge Content Settings ‘
224 SoftRater
3 Engine ~
£ Exiorer Configuration q
; ) Environments Enwvironment(s) you may use for development purposes. Selecting an environment below will denote it as the default.
-1 SoftData
L3 Services Environment: RM @
A Logs Test Environment...
3 security DE Server: WINAPPOO3
$3 softLibraries DB ServerType:
i@ Help
DB Catalog: IBRM_Alamere g
DE CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema:
DB User: sa
DB Password: sssssses
Engie Type:
Engine Location: LOCALHOST D Location is a Cluster
Engine EnvDef: Discover
Envirenment{s) you may use for quality assurance purposes, Selecting an environment below will denote it as the default,
Environment: QA O
Package Location: C:Mnsbridge\QAPackages Test Environment. ..
DB Server: WINAPPOO3
DB ServerType:
DB Catalog: IBSR_Alamere_QA
DB CatalogType:
DB Query Buffer:
DE Tablespace:
DA Srhema: s
< | & Copyright © 2000,2009, Crade andjor its affiiates. Al rights reserved.

Figure 32 Editing Environment

5. The Environment Name will be complete. No changes are needed.
6. RateManager environments will not have a Package Location. No entry will be allowed.

7. Enterin the DBServer name or IP address. This is the database server where the RateManager
database was restored.

8. The DB Server Type will be SQL Server.
9. The DB Catalog is the name of the RateManager database restored in SQL Server.
10. The DB Catalog Type is RateManager.

11. DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.
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12.

13.

14.

15.

16.

Enter the DB User name and Password.
The Engine Type is Windows.

The Engine Location default is LOCALHOST. Most RateManger installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManger installations do not require an
entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Follow the same procedure of restoring the database, then entering in IBFA.

Optional Setting: Threads

If you know the number of Web Rate Threads you need, you can enter this information now. If you do not
know, you can enter this information later. For more information on threads, please see the IBFA User

Guide.

WARNING: Before changing the number of threads, you should consult with your system

administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Insbridge recommends a maximum of 2 threads.

There are three thread settings in the IBRU system:

Batch Packing Thread: Found on the Preferences screen of RateManager. This setting is the
maximum number of threads to be used for RateManager Batch Packaging. Batch packaging is
building of packages inside RateManager. This thread setting will not affect rating or any other
process in IBFA.

IBFA Web Threads: Found on the SoftRater Engine page in IBFA. This setting is the maximum
number of threads to be used for rating that is sent through the SoftRater web services. If you
want responses to be returned in the order submitted, this thread setting must be higher than the
maximum number of rate requests contained within a single XML request.

IBFA Message Services Threads: Found on the Message Services page in IBFA. Individual
thread usage can be set for Batch Rating, Batch Scenario and SoftRater-Package.
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STEP 7: VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.

1. Click Start->Administrative Tools->Component Services.
2. Expand the Component Services option under console Root.

3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath

each compartment.

() Component Services

. File Action  Misw  Window Help

e HEXE cl@EILIEE

Actions

(L1 Consale Roat 7 7
B & Companent Services h _ﬁ h _ﬁ
B [ Computers COM+ COM+QC COM+ Utiities  Insbridge
=l M?; Computer Explorer Dead Let,.. Com+ Ad...

= COM+ Applications

COM+ Explarer % _% @
COM+ QiC Dead Letter Queue Listener L+

COM+ Utilities Insbridage Inshridge Syskem
Inshridge Com+ Administrator 3.5 Com+ ... Com+ ... Application
Insbridge Com+ SoftRater Engine
Insbridge Com+ SoftRater Library
%P System Application

| DCOM Config

| Running Processes

| Distributed Transaction Coordinakar
2] Evert viewer (Local)
. Services (Lacal)

IS0 S0 S Suk

HEEEEEE

COM+ Applications

Mare Actions

Figure 33 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
o Insbridge Com+ SoftRater Engine
o Insbridge Com+ SoftRater Library
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Please note that you will not have to make any changes to any COM+ Application library. The installation
will automatically apply the Insbridge user name and password that you created earlier to the necessary
libraries. If you change the password, you will have to change the password in all three of the Insbridge
Com+ libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose uninstall.
Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see if all the
libraries are listed. If they are still not listed, please log a Service Request using My Oracle
Support at https://support.oracle.com/.
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STEP 8: ALLOWING FOR WCF ACTIVATION

WCEF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools—=> Server Manager.

2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.

3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard

Confirmation

Progress

Resulks

Select one or more Features to install on this server,

Eeatures:

Description:

B

MET Framework 3.0 Features (Installed) -
MET Framework 3.0 (Installed)
¥P3 Wiewer (Installed)

WCF Activation (Installed)
[] BitLocker Drive Encryptio
|: BITS Server Extensions
|: Zonnection Manager Administration Kik
[ Deskrop Experience
|: Group Policy Management
[] Internet Printing Client
|: Internet Skorage Mame Server
[] LPR Port Manitor
|E Message Queuing (Installed)
[ Multipath 1j0
[] Metwark Load Balancing
[] Peer Mame Resalution Protocol
[ quality Windows Audio Viden Experience
[] remate Assistance
[] remate Differential Compression
Rermate Server Administration Tools (Installed)
[] removable Storage Manager

[ |

IMore about features

= Preyious | ext = | Install

Windows Communication Foundation
— [WCF) Ackivation uses Windows
Process Activation Service bo invoke
applications remokely owver the
netwaork using protocols such as
HTTP, Message Queuing, TCP, and
named pipes, Consequenthy,
applications can start and stop
dynamically in response to incoming
work items, resulting in application
hosting that is more robusk,
manageable, and efficient,

| Cancel I

Figure 34 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.

5. Confirm your selection and click INSTALL. The installation will proceed.

6. You can close out when complete.
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STEP 9: INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

1. Unzip the OBI_PUBLISHER

% OBI Publisher, Setup EEuE

0Bl Publisher —
Release MNokes, ;j

cle BI Publisher {Oracle Insurance - Insbridae Installi will update the current
ko 10.1.3.4.0

Inskall ] [ Cancel

Figure 35 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Server Manager in
Windows 2008.
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STEP 10: STARTING INSBRIDGE SERVICES

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task Manager is
a task queue that lists the tasks that are scheduled to be performed as well as the last time the task was
run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly (process)
for execution. These processes may take resources and time to execute, Please consult with you system admin before
configuring the number of listeners per process.,

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, yvou have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide you with a list wiew of the first in - first out messages that are waiting to
execute.

Insbridoe Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, or by the minute.

View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 36 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company'’s infrastructure and request the
security team to open the ports used by Publisher.
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STEP 11. PERFORMING UPDATES IN RATEMANAGER

There are two updates that should be done in RateManager prior to creating user groups and users:
o Step 1. Running Database Updates

e Step 2: Updating Preferences

Entering RateManager:

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where the
INSTALLTIONSERVERNAME is the server where RateManager was installed.

This will place you on the RateManager login screen.

1. Tologin for the first time, select your company from the drop down menu. If you have created
only one company, a drop down menu will not be presented.

2. The user name is demo.
3. The password is password.
After running database updates, it is recommended that you update the demo user password.

Users and User Groups can be created after any database updates are run. For more on user
management, please see the RateManager Tools User Guide.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in IBFA.

STEP 1. RUNNING DATABASE UPDATES

If you log into RateManager and Tools is the only option, you must perform a database update. After you
perform the database updates, to view all menu options, click File>Reload.

/= Oracle Insurance Insbridge RateManager 04.06 - Windows Internet Explore

ORACLE" Insurance Insbridge RateManager
File | Tools Help

3 Database » B Backups
(& Updates

Hom

Figure 37 Tool Mandatory Update
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NOTE: If you log into RateManager and Tools is the only option, you must perform a database update.

On the DB Updates screen, the current version will be highlighted and the status will be Current. The
updates below the current version will be grayed out. These updates cannot be run again. Current
updates can be re-run if necessary. You will receive an error message if you attempt to run a lower
version update. Any version update above the current version will also be grayed out but will be available

for executing.

New installations may show 04.05.01 as current but still have only the Tools option available. You may
have to run the current script again. To see if you have complete access, click File—>Reload to refresh the
system.

Navigate to the Tools->Database—>Updates.

1. The Updates tab is displayed. Select the database you want to view from the Show updates for

drop down. The database updates for your selection is listed. The last column, the Status
column, shows you which update is the Current one installed.

ORACLE Insurance Insbridge RateManager

File

Hom

=

Tools

Help

DB Updates

(@) DB Updates

.LE Execute Update Script .LE Open Update Script E Save Update Script to File E’ﬂ Refresh

Show updates for:) IERM w
Scnpt FRelease Date Database Status
wiO<4.06.01.00 gf1/2012 IBRM
wi4.06.00.00 3/172012 IBR.M
vO4.05.00.00 5/1/2011 IBR.M
wO<4.01.00.00 11/15/2010 IBRM

wiO4.00.0.00 2/10/2010 IBR.M

v03.13.0.00 12/15/2009 IERM

03.12.0.00 4/30/2009 IBF.

03.11.0.00 11/30/2008 IBR.

03.10.0.00 g/31/2008 IBR.

032.9.0.00 5/19/2008 IBR.

03.8.0.00 &7/ 2007 IBR.

03.7.0.00 Fr2e/2008 IBR

Figure 38 Available Updates

2. There are two ways to execute an update:

a. Directly in RateManager
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b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This will assure that the database showing as Current will have all possible updates.

1. Highlight the update you want to run.

2. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.

3. Click OK to run the update or Cancel to return to the previous screen.

4. Run all script in consecutive order until the 04.06.01 script is showing as current.
5. Do this for both the IBRM database and the IB_CLIENT database.

6. Click File>Reload to refresh the system.

2 Confirm Lipdate -- Webpage Dialog @

™ Are you sure you want to replace the
_!_,/I current database's contents with the
. selected release script on disk?

e Ok | i cancel |

Figure 39 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Database names can be found in IBFA->environments. Please see Manual Updates to the IBRU
Database.
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STEP 2: UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager. Changes
will take place after the user sessions have been ended. If web settings are changed while the users are
inside the module, the change will not be visible to them. Prior to users accessing RateManager for the
first time, it is recommended that Preferences be set.

NOTE: If you receive an error regarding MCSiMenuCltl, please verify that you are using Internet Explorer
8.0 or 9.0 (32-bit). Release 04.06.01 does not support Internet Explorer 8.0 or 9.0 (64-bit).

To Change Settings

1. Select Tools—>Preferences.

Tools Help

Eﬁ'ﬂ Manage Lines

O Audit

S Migrate Work Files

@. SECUriky »
B Database 2

Change Password

951 Preferences

2. This will open the Preferences window. Select Web Settings.
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a Cracle Insurance Insbridge RateManager [Preferences] -- Webpage Dialog

Preferences

—I-Settings
é--User
E----Hu:nrne Page
i--.ﬂ«dministrator

L-Web Settings

Web Settings

Insbridge Configxml Path:
Messaging Server :

SoftRater Sarver :

WoaorkFiles Sharz Folder
Location:

CE Backup Share Folder
Location:

Usa Insbridge Com+
Admin:

Enforce Release Packaging:

Batch Package Threads:

Minimum Login User 10
Length:

User must change
passwiord:

Show Orverride Date Mask:

Allow Data Type Change:
Inactive Session Time Cut:
Batch Results with NewiLine:
Online Help Server:

My Recent List:

Default Proxy Script
Location:

|C:‘\PRD{3RAM FILESYORACLE\IGEU\INSERIDGE\FRA ME‘.‘JDRK\#

[locathest

| {Secure Channel) D

[localhest

| {Secure Channs=l) D

|C:"\]nsbridge"\DB_Backup

True =
Fakz *

(Days)
-

True

True ~

s thrs)

Falz =

m

[lecathest

| hitp: / fwepadwpad.dat

# Save | &) Close |

e

Figure 40 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back and edit lat
a later time. It is recommended that you update the ONLINE HELP Server immediately.

4. When you are finished, click Save to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change this path if
you have changed the path in IBFA. Please contact Insbridge support for further information. It is strongly
recommended that you leave the default.
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Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

WorkFiles Share Folder Location

A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles.
The IBRU server and the shared location must be on the same domain. The Insbridge user must be on
the domain also.

For instructions on setting up a WorkFiles Sahre Location, please see the Insbridge WorkFiles Installation
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html

DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, you will use a local path. If the location is not local, you must be a disk admin to
change.

If the database backup location is on a remote server, a share is needed for the backup location. The
Insbridge user must have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If setto True, arelease is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.
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In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or input.
Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting will place
a carriage return between result files. A False setting will result in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting should be the server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and justification to
any element or program when it is revisioned. If change control is off, the option will not be presented.
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STEP 12: EXPORT INSBRIDGE REGISTRY KEY FOR BACKUP

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE-Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server.
This is a safety precaution and will not affect users currently accessing the IBRU system.
If you have to move RM/IBFA to a new machine or in the event of a catastrophic server failure, where the
RM/IBFA server is non-recoverable, the IBRU system will need to be reinstalled. When RM/IBFA is re-
installed on a new server, a new registry key will be created. The new registry key will not match the
registry key associated with any packages that have been created. In order to load packages to the new
server, you will need to restore the previous registry key.
You may also be requested to send to your registry key to support.

1. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

2. Right click and select Export.

3. Select a storage location for the file and Save.

4. Close out of Registry Editor.

At the completion of this step, you may enter RateManager and begin working.

Suggested Next Steps

When the IBRU system is ready for users, you can begin to create lines of business and create users.
End users will need to perform setup on their computers in order view and properly work in RateManager.
There is an IE folder in the installation download. In the folder are the executable and the setup guide that
users will need.

- |E7_IE8 Users
¢ Insbridge RateManager Setup Document PDF
¢ RateManager_IE7_IE8.exe

After user logins have been created, it is suggested that the contents of the IE folder be sent to users
along with their login information.
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Chapter 4

MANUAL UPDATES TO THE IBRU DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager and run the updates there. If the administrator has DB User privileges and is the
DB Owner of the database as well as the disk administrator, database updates can be done on
the Tools>Database>Updates tab. If these privileges are not in place, an error message will
be displayed. See Step 1: Running Database Updates for instructions.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that
you enter RateManager and run the 04.00, 04.0, 04.05, and 04.06 update scripts
successively from there. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates in SQL Server using Query Analyzer.

1. First, you will need to get the scripts you need from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as
“current”. If you are going from a much lower version of RateManager, you will have to
save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file
to a location of your choice. For IBRM scripts, it is recommended that you rename the file
to usp_IBRM_R(version number).sgl. For example the Release 04.06.01 update would
be: usp_IBRM_R04.06.01.sql. For IB_CLIENT scripts, it is recommended that you
rename the file to usp_IB_CLIENT_RO(version number).sgl. For example the Release
04.06.01 update would be: usp_IB_CLIENT_R04.06.01.sq|.

4. Verify that you have saved all the necessary scripts from “current” to release 04.06.01.
You must save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database.
Open Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program

you want, such as Notepad. Begin with the “current” script. For example, if you are going
from R03.13 to 04.06.01, 3.13 should be “current”. Open 3.13 first.
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B Microsoft SOL Server Management Studio [_[D]

Fle | Edit View Tools Window Community Help
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\ hew P2 Project... ChrhShift+M |
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Source Control 3 [0 Yiews
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Figure 41 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a
new Database Engine Query, File>New->Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 04.06.01 update.

11. When you have finished updating one database, update the remaining database. Make
sure you do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed. The
updates are now properly applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view.
Click Open Update Script. The update script will be displayed in a separate screen.

2 IBRU : v04.06.01.00 - Webpage Dialog

—-—-5ET THE DATE FORMAT TO &N EXPFECTED FORMAT TO SETUP THE SCHEMA INFUTS e
S5ET DATEFCEMAT mdy
E10]

if not exists (select * from INFORMATICN SCHEMA.COLUMNS where TAELE NAME
= 'TYPES SCHEMA' and COLUMN WAME = 'TEMPLATE ID')

ALTER TAELE TYPES SCHEMA ADD TEMPLATE ID INT NULL
GO

if not exists (select * from INFORMATICN SCHEMA.COLUMNS where TABLE NAME
= 'TYPES S5CHEMA' and COLUMN WNAME = 'TEMPLATE VERSICN')
ALTER TAELE TYPES SCHEMA ADD TEMPLATE VERSION INT NULL w

Figure 42 Script Viewer
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Chapter 5

CREATING AN INSBRIDGE APPLICATION PooL

Insbridge currently uses the default application pool and requires .NET framework setting of v2.0.
This may present conflicts with other applications in the default pool that require a higher setting.
Or if after a new install you receive an error when accessing IBFA:

CS0016: Could not write to output file
‘'c:\Windows\Microsoft. NET\Framework64\v2.0.50727\Temporary ASP.NET
Files\ibfa\783d6267\bccaOb3e\App_global.asax.zf-kqiii.dll": 'Access is denied. '

You may need to create a separate Insbridge Application Pool.

There are three steps to creating an Insbridge application pool and then assigning the virtual

directories.

o Step 1: Complete the RateManager installation. Make sure that Static Content is enabled
in the Server Manager Roles.

o Step 2: Create a new Application pool in 1IS called Insbridge. Be sure to configure the
application pool to use the Insbridge user.

o Step 3: Associate the Insbridge application pool with virtual directories IBFA, IBRU, RM

E_ Server Manager =
Fle Action Yiew Help
= |71
Bl 5 Rales -
T pctive Directory Domain Se i
= a‘% ‘Web Server (I15) ﬂ—au Provides a reliable, manageable, and scalable web application infrastruckure.
]| Inkernet Information Se ba
% E:;ti:cs ~! Role Services: 28 installzd :j(} Add Role Services -l
Hik Configuration Role Service [ status |2 R bt
55 Shorage Cw  Web Server Installed
i Common HTTP Features Installed
Static Conkent Installed
P Defaulk Document Installed
s Directary Browsing Installed
P HTTP Errors Installed
HTTP Redirection Mot installed
o Application Development Installed
P ASP.NET Installed
b= MET Extensibility Installed
&= A5P Installed
= Cal Installed
b= ISAFI Extensions Installed
P ISAPT Filters Installed
= Server Side Includes Installed
a Health and Diagnostics Installed
F- HTTP Logging Tnstalled
Logging Toals Mot installed
s Request Monikor Installed
Tracing Mot instalied
Customn Logging Mot installed
ODEC Logging Mot installed
&y security Installed
Basic Authentication Mot installed
Windows Authentication Mot installed
Digest Authentication Mot installed
Client Certificate Mapping Authentication Mot installed
115 Client: Certificate Mapping Authentication Mot installed LI
4 _;I %::. Last Refresh: 8/23/2011 10:18:41 PM  Configure refresh
[

Figure 43 Step 1: Enabling Static Content
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Step 2: Updating the Insbridge Application Pool

The Insbridge installation must be complete prior to creating an application pool.

1. Click Start > Administrative Tools - select IIS Manager.

2. Expand the Local Computer and select Application Pools. Right click and select Add
Application Pool.

"E Internet Information Services (I15) Manager M= B
@ 3 [ L} » winsRPODI b Application Pocls J 55 @ -
Fle Vew Help
_. — & lication Pools _
@ [ |7 |8 § App L add Application Podl...
45 Start Page Sek Application Pool Defaults. .
& - WINSRPOD1 {winskpaol | THS Page ets you view and manage the Ist of apalication posls an the server. Application pools are associsted sl RS
| b with worker processes, contain one o more spplications, and provide isolation among differsnt spplications. @ Heb
& sites A Application Pocl. . - B0 - Gyshowal |Groupby: No Grouping E Giine Help
3 Refresh Status | ET Frame... | Managed Fipeli... | Identit | app!
[F Classic HET AppPocl started  v2.0 Classic HetworkServics ]
(¥ DefaultippPosl Started  v2.0 Integrated HetworkServics 1
L Insbridge Starked  v2.0 Integrated Insbridge 3
4| | I
4 | - Features View || 2 Conkent Yiew
Ready L=

Figure 44 Navigating to Application Pool

3. Enter “Insbridge” for the Application pool Name. Select the v2.0 for the .NET Framework
version. Click OK. You will be returned to the IS screen. Your new application pool is listed.

Add Application Pool B I

Marme:

MET Erarmewark wersion:
| MET Framework v2,0,50727 |

Managed pipeline mode:

¥ Stark application poaol immediately
(5] 4 I Cancel

Figure 45 Creating a New Application Pool

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 67



4. Right click the Insbridge Application Pool you created and select Advanced Settings.

Advanced Settings B

B {General}) =
MET Framework Yersion we, 0
Managed Pipeling Mode Inteqrated
Mame Inshbridge
Queus Length 1000
Skark Automatically True
E Cru
Lirnik 0
Lirnit Ackion Modckion
Limit Interval {minutes) 5
Processar Affinity Enabled False
Processar AFFinity Mask, 0000000000
E Process Model
Identiky Insbridge .
el
Load User Profile False
Maximum Worker Processes 1
Ping Enabled True
Ping Maximum Fesponse Time (seconds) 30
Ping Period (seconds) 30
Shukdawn Time Limit (seconds) a0
Starkup Time Limit (seconds) an
E Process Orphaning
Enabled False -
Identity
[identity Twpe, username, passwiord] Configures the application pool ko run as builk-in
account, i.e, Metwork Service (recommended), Local Syskem, Local Service, or as a sp...

CIE

Cancel |

4

Figure 46 Selecting Application Pool Properties

5. Verify that the .NET Framework Version is v2.0.

6. For the Identity choose to use custom account and enter the same user that was used

to install IBRU.

7. Click OK to save your changes.
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Step 3: Associate the web applications with the Insbridge Application Pool

Next, you will need to association the Insbridge web applications with the new Insbridge
application pool.

1. Stayin IIS Manager. Under Local Server - Sites - select IBFA, right click and select
Manage Application-> Advanced Settings.

"-E Internet Information Services (I1S) Manager —5
@G, [3 » WIMSRPOO! b Sites b DefaultWebSite » IEFA b FE ™1® -

File  Wiew Help

P vancedsetins o) Aesens T
8

Q- |‘:L lﬁ_ 42 Explore
5 Start Page El_{General) Edit Petmissions. .
85 WINSRPOD1 (WINSRPODI|M Group by: pplication Pool Insbridge Q _— : :
-5} Application Pools B Physical Path C:\PROGRAM FILES'ORACLE\IG [ gasic Settings..
= ] Sites p! + Phyysical Path Credentials Yiew Yirtual Direckories
Bl i MET Physical Path Credentials Logon Type  ClearText
Authorizati. .. Virkual Path [IEFA Manage Application ~
‘:-2 E Behavior Browse Application
= Enabled Protocals hitkp Browse *:80 (http)
§ Application pool: '@' Help
[ab| anline Help
Connection Properties:
Strings

.Met Framework Yersion: 2,0
Pipeline mode: Integrated

Logagir
9ang OK I Cancel

a=

o=
Request
Filtering

Application Pool
[applicationPool] Configures this application ko run in the specified application poal,

[8]4 Cancel I

4

4 | » E Features Yiew || :E_ Content Yiew

Ready qi:g

Figure 47 Associating the Virtual Directories with the Insbridge Application Pool

2. Under the General Settings - Application Pool, click the Application Pool entry field to see
the ellipsis (...) button.

3. Click the ellipsis button. A separate window is displayed.
4. Select the Insbridge Application Pool.
5. Click OK. Click OK again to close the Advanced Settings window.

6. Repeat for RM, IBRU, and any other SoftLibraries that have been created.
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7. Verify that the Insbridge application pool has at least three sites. Select Local Server->
Application Pools.

8. Right click to View Applications. The three Insbridge applications should be listed.

9. Restart IIS. On the IIS screen, Actions-> Restart IIS.

. Server Manager

IS[= B3
File Action Wiew Help
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% EETVEV Manager (WINSRPOO1) Internet Information Services (IIS) Manager
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—— - s
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F Featql_l?es g q WINSRPOO1 Home
o i " %' = l l & E Manage Server
B =17} Iagfl?os ICS. W5 Start Page & Restart
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Figure 48 Restarting IIS
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, seven days a week. For TTY support, call
800.446.2398.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle
Support at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues and
provide customer support according to the Oracle service request process. Information about
TRS is available at http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is
available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
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